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1 RT-Druid and Erika Enterprise tutorial for AVR5

This small tutorial describes a set of steps needed to compile a simple application that
shows the main features of Erika Enterprise and RT-Druid for the AVR platform.
This tutorial has been tested on a STK50X board produced by Atmel and on a Cross-

bow Mib520 board.



2 Installing Erika Enterprise and RT-Druid on
Microsoft Windows

This chapter will guide the developer to the installation procedure of Erika Enterprise
and RT-Druid for the AVR platform.

Warning: The Cygwin install pathname, the Erika Enterprise install pathname,
and the pathname of RT-Druid workspaces where the user projects reside, MUST
NOT contain any blank space, otherwise Erika Enterprise may not work properly.

E.g., C:\MyApplications\Evidence\ and C:\MyApplications\Cygwin\ are accept-
able, while C:\My Applications\Evidence\ or C:\My Applications\Cygwin\ MUST
be avoided.

This is a known issue that will soon be fixed.

The installation of Erika Enterprise and RT-Druid is composed by the following pack-
ages:

e The Eclipse development environment, which is used by RT-Druid to provide the
basic development environment for Erika Enterprise applications.

e The Eclipse environment is based on the Java platform, so that a working Java
Runtime Environment must be present for using RT-Druid.

e The RT-Druid plugins, which provide the code generation for Erika Enterprise and
Erika Enterprise for Eclipse.

e The Erika Enterprise source code.

e A subset of the Cygwin environment [1], including a set of utilities like make, gawk,
and few others, which are used during the compilation process of an Erika Enterprise
application.

e A set of examples for the AVR Platform, which can be used to compile a first set
of running examples for the Atmel STK50X board, the Crossbow MIB5X0 board.
These applications are organized in “templates”, available at project creation.

To install the software, execute the following steps:

1. Install your favourite Java runtime environment, which is needed to run RT-Druid;
in fact, RT-Druid is a plugin of the Eclipse editor, which requires Java to be
executed.



2 Installing Erika Enterprise and RT-Druid on Microsoft Windows

2. Install the AVR-Gcee Compiler, available from the WinAVR sourceforge.net project
at the website http://winavr.sourceforge.net/. Even in this case, you can use
the default install directory. When it is asked to change the default environment,
please do accept.

3. Run the Erika Enterprise and RT-Druid installer.

4. The installer will prompt a list of packages which can be installed. Select all the

packages you wish to install and continue the installation procedure (see Figure
2.1).

17 Erika Enterprise Basic GPL for dsPIC Setup E] 0
Choose Components —
Chaose which Features of Erika Enterprise Basic GPL Far dsPIC you want ko install, (.‘)
Check the components you want ko install and uncheck the components you don't want ko
install. Click Install ko skark the installation,
Select cormponents ko install: Cyawin DA

Erika Enterprise

Space required; 287, 1MB

< Back ” Install 1 [ Cancel

Figure 2.1: This screenshot shows the dialog box with the available install packages.

5. At this point, please check the firstline of the file evidencedir\bin\mymake_cygwin.bat
(where evidencedir is the directory you chose during the installation). For exam-
ple, if Cygwin is installed inside C:\cygwin, then the first line of the file should
look like the following one:

@set EE_BASH_PATH=C:\cygwin\bin\bash
...that is, the line contains the correct path to the bash.exe file in your Cygwin

installation. If you accepted the default settings, the correct pathname should be
C:\cygwin\bin\bash as specified in the example before.

Note: We ask to perform this check because it seems that on some Windows
machines the Cygwin installer does not correctly set the registry keys used by
the Erika Enterprise installer.

6. If you are going to use the Atmel stk50x or the Crossbow Mibbx0 boards, you
can use the UISP programmer to program the AVR microcontroller. To Install the


http://winavr.sourceforge.net/

2 Installing Erika Enterprise and RT-Druid on Microsoft Windows

UISP software, which is an AVR In-system Programmer using the USB connection
provided by the boards cited above, please follow the instructions below:

e If not installed, run the Cygwin setup from http://www.cygwin.com to in-
stall the following Cygwin packages: gcc.

e Install the UISP - AVR in-System Programmer, available at the website
http://www.nongnu.org/uisp/.

The rest of this tutorial supposes that the AVR-Gcee Compiler and binutils is installed
within the C:\WinAVR-20071221\bin directory. Please note that these values may be
different from the settings you have chosen on your machine.


http://www.cygwin.com
http://www.nongnu.org/uisp/

3 First RT-Druid startup and configuration

After all the required packages have been installed, you are ready to start RT-Druid for
the first time.
Please follow the next steps:

1. As the first step, run the Eclipse IDE from the Evidence menu inside the Start
menu of your Windows machine, choosing Start/Programs/Evidence/RT-Druid.

2. A dialog box will appear, asking to choose the right workspace (see Figure 3.1).
Leave the default workpackage directory as it is, and proceed by pressing “OK”.

Workspace Launcher [5__<|

select a workspace

Eclipse Platform stores your projects in a directory called a workspace.
Select the workspace directory to use for this session,

Browse. ..

(:\ProgrammilEvidenceleclipseuworkspace

‘Workspace:

[™ Use this as the default and do not ask again

oK | Cancel

Figure 3.1: This screenshot shows the dialog box for the choice of the current workspace
directory.

Warning: The workspace pathname MUST NOT contain any blank space,
otherwise Erika Enterprise and RT-Druid may not work properly.

3. The Eclipse Welcome screen appears, like in Figure 3.2.

4. Before being able to correctly build your application, you should set the path to
the AVR-~Gce compiler. For doing so, please go to the “Preference” menu, as shown
in Figure 3.3, and find the “RT-Druid/Oil/Avr5 Configurator” form as depicted in
Figure 3.4. The first textbox, labeled Gcc path, refers to the installation directory
of the AVR-Gce compiler. The second and third textboxes are useful if you are
using a development environment based on the Crossbow Mib5x0 board. In partic-
ular, the second textbox, labeled Uisp path, refers to the installation directory of
the uisp programmer for Crossbow Mib5x0 board, and the third textbox, labeled
Serial port device, refers to the COM serial port where the board is attached.



3 First RT-Druid startup and configuration
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Figure 3.2: The Eclipse Welcome screen.

Warning: The install directories specified for the AVR-Gee Compiler in the
textboxes of Figure 3.4 does not include the bin directory!

That is, c:\WinAVR-20071221 is correct, wheras c: \WinAVR-20071221\bin is not.
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Figure 3.3: Go to the “Preference” menu.

5. Before creating and building your application, please deselect the “Build Auto-
matically” flag inside the “Project” menu, as shown in Figure 3.5.



3 First RT-Druid startup and configuration
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Figure 3.4: Select paths for compiler and assembler.
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Figure 3.5: Deselect the “Build Automatically” flag in the “Project” menu.
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4 Compiling your first Erika Enterprise demo for
AVR5

You are now ready to compile your first Erika Enterprise demo. Please execute the
following steps:

1. Please select “New Project”, then “RT-Druid Oil and c¢/c++ Project” from the
“File menu”, as in Figure 4.1.
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| ]| pescription Resource [.in Folder | Location |

Figure 4.1: Select “New project” from the “File” menu.

2. A Dialog box appear. Please select a template for the new project, as in Figure
4.2.

3. Press “Next”.

4. Insert the name of the new project. Please type myProject (you can choose other
names of course). Please see Figure 4.3. Press the “Finish” button.

5. We are now ready to build the demo. Right click on the project name in the
Eclipse navigation bar, and choose “Build Project”! (see Figure 4.4).

L“Build Project” only appears if the “Build Automatically” flag is not selected in the “Project” menu.
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4 Compiling your first Erika Enterprise demo for AVR5
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Figure 4.2: Select a template for your project.

6. Then, the compilation process starts as depicted in Figure 4.5. Please note the
message that appears when the compilation is successfull.

Note: If the error depicted in Figure 4.6 appears (meaning that
mymake_cygwin.bat is unable to find a file), then please follow the instructions
at the last point of Chapter 2.

7. At the end of the compiling process you will be able to find a file named avr.elf
and a file named avr.srec inside the Debug directory inside the project, as shown
in Figure 4.7 and in the figure 4.8.

8. You can now program the device using avrd programmer as shown in Figure 4.9
and in Figure 4.10. Please remember that you have to connect ISP6PIN plug of
the STK500 with the SPROG plug of the STK501 through 6-wires cable.
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4 Compiling your first Erika Enterprise demo for AVR5
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Figure 4.3: Type a name for the new project.

Fle Edt Refactor Navigate Search Project Run Window Heln
- G R AT e e
m = B[ [d *codec 33
2 B8 Y i Gl
S fe— ERIKL Enterprise Basic - a tiny RTOS for small n
B N » *
o e * Copyright () 2002-2007 Ividence Srl
| Open n New wrindow %
* This £ile is part of ERIEL Enterprise Basic.
£
B @ + ERIKA Enterprise Basic is fres software; you cer
& ¥ Deete * and/or modiTy it under the terms of the GNU Gene
Move * version z as published by the Free Software Four
Rename 4
* ERIKA Enterprise Basic is distributed in the hoy
| Rxa Trport. * useful, but WITHOUT ANY VARRANTY; without even t
e Esport,,,  of NERCEANTAEILITY or FITNESS FOR A PARTICULAR F
= * GNU General Public License version 2 for more de
:
& Refresh * You should have received a copy of the GNU Gener
Close Projact * version z along with ERIKA Enterprise Basic; if
Jaed Project * Free Softvare Foundation, Ine., 51 Franklin Stre
* Boston, MM 02110-1301 USA. 5
Run s » «
Debug as >
e 2 #include "ee.h”
Compare With 4 _Hinolude "weu/atwel atmegal2s/ine/se_iz.ht
Restore from Local Histary. .
A0S progranmer > int main{veid)
Properties
Create Make Target... unsiomed char waskExtInt = OxOL: ]
Build Make Targst. [ g 2 — 15 — 2
B moufatmel_atmega 128]inc/es_i Tasks | B Console 52 ]
1 myProject

Figure 4.4: We are now able to build the project.
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4 Compiling your first Erika Enterprise demo for AVR5
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Figure 4.5: The compilation process.
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Figure 4.6: An error that shows up on some Windows machines.

Please check the

mymake_cygwin.bat file as explained in the last point of Chapter 2.
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4 Compiling your first Erika Enterprise demo for AVR5
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Figure 4.7: The output file is ready to be programmed on the target board.
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Figure 4.8: The output file is ready to be programmed on the target board.

15



4 Compiling your first Erika Enterprise demo for AVR5
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Figure 4.9: Program the Flash memory of the device.
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4 Compiling your first Erika Enterprise demo for AVR5
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Figure 4.10: Program the Flash memory process.
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5 History

‘ Version

‘ Comment

1.0.0

‘ Initial revision.
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